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1. Install and Configure the EDQ Virtual Machine 
Please note that the Oracle Enterprise Data Quality virtual machine is for testing purposes 
only.  As such it is unsupported and should not be used in production environments. 

1.1. Prerequisites 
The Oracle Enterprise Data Quality virtual machine is known as EDQ-12.1.3-Trn2 and this 
name will be used throughout the remainder of this document.  The virtual machine runs in 
Oracle VirtualBox software, which you will need to install on your computer.  Oracle VirtualBox 
can be installed on a number of different operating systems.  You can download VirtualBox 
from https://www.virtualbox.org/wiki/Downloads.  A VirtualBox user manual is available at 
https://www.virtualbox.org/manual/UserManual.html.  This includes a chapter about installing 
VirtualBox (here is a direct link to the installation chapter: 
https://www.virtualbox.org/manual/ch02.html). 

The EDQ-12.1.3-Trn2 virtual machine requires a host machine with a minimum of 8GB memory 
(16GB is recommended).  At least 4GB memory must be allocated to the virtual machine, and it 
will perform better if you allocate more memory to it (9GB is recommended).  Your host 
computer must have an up to date Java Runtime Environment (JRE) installed.  If your computer 
does not already have a JRE, you can download one from http://www.java.com. 

1.2. Terminology 
Virtual Machine technology enables you to run a virtual computer - which is known as the 
guest - inside a physical computer - which is known as the host.  The guest and the host can 
have different operating systems, and the guest machine can be supplied to you pre-
configured, with various software packages already installed and working. 

1.3. About the EDQ-12.1.3-Trn2 Virtual Machine 
The EDQ-12.1.3-Trn2 Virtual Machine includes a pre-installed, pre-configured instance of Oracle 
Enterprise Data Quality, release 12.1.3.  The virtual machine also includes data and other files 
that you will need to complete the Getting Started With Oracle Enterprise Data Quality 
hands-on lab that is included within the virtual machine.  The EDQ-12.1.3-Trn2 virtual machine 
runs a 64 bit Linux operating system.  If you don’t know much about Linux though, don’t worry.  
The main purpose of the virtual machine is to run the Oracle Enterprise Data Quality server.  
Nearly all of the training labs get you to work with the Oracle Enterprise Data Quality user 
interfaces – the clients.  The user interfaces talk to the server – which means that the virtual 
machine must be running.  However, you will run the user interfaces themselves on your host 
machine – that is to say your desktop or laptop – which can be running a different operating 
system. 

1.4. Download the EDQ-12.1.3-Trn2 Virtual Machine 
The EDQ-12.1.3-Trn2 virtual machine is supplied as a multi-part zip file. 

The files are called: 

 EDQ-12.1.3-Trn2.zip.001 

 EDQ-12.1.3-Trn2.zip.002 

 EDQ-12.1.3-Trn2.zip.003 

 EDQ-12.1.3-Trn2.zip.004 

https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/manual/UserManual.html
https://www.virtualbox.org/manual/ch02.html
http://www.java.com/
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 EDQ-12.1.3-Trn2.zip.005 

 EDQ-12.1.3-Trn2.zip.006 

You need to download all of these files. 

1.5. Extract the .ova File from the Multi-Part Zip File 
The multi-part zip files contain the EDQ-12.1.3-Trn2 virtual machine, within a file called EDQ-
12.1.3-Trn2.ova.  You need to extract this file from the multi-part zip.  How you do this will 
vary a little depending upon which compression software you are using. For example, if you 
have 7-Zip installed, you should: 

1. Right click the EDQ-12.1.3-Trn2.zip.001 file. 

2. Select 7-Zip > Extract Files from the menu. 

3. Select the folder you want to extract the EDQ-12.1.3-Trn2.ova file to. 

4. Click OK. 

The EDQ-12.1.3-Trn2.ova file will be assembled in the folder you selected. 

1.6. Import the EDQ-12.1.3-Trn2 Virtual Machine 
The virtual machine has been preconfigured with Oracle Enterprise Data 

Quality. You will run the client applications from your host machine while 
the EDQ server will run within the virtual machine.  

1. Launch Oracle VM VirtualBox Manager. 

2. From the File menu, select Import Appliance...  The Import Virtual Appliance dialog 
will open. 

3. Click Open appliance…  The Select an appliance to import dialog will open. 

4. Navigate to and select EDQ-12.1.3-Trn2.ova, and then click Open.  The Import 
Virtual Appliance dialog is displayed. 

5. Click the Next.  The Appliance settings will be displayed. 

6. Click Import.  A software License Agreement dialog box will open.  You need to read 
the license and click Agree to continue or Disagree to cancel the import. 

7. If you click Agree, a dialog box will report progress.  Wait until the import has been 
completed. 

1.7. If Possible, Allocate More Base Memory to the Virtual 
Machine 

The EDQ-12.1.3-Trn2 virtual machine has 4GB Base Memory allocated to it by default.  This is 
the recommended amount if your host has 8GB memory installed.  If your host has more than 
8GB memory, however, you are advised to increase the amount of Base Memory allocated to 
the virtual machine.  This will enable you to increase the amount of memory allocated both to 
EDQ’s Java Heap and to the VM’s Oracle Database, both of which will boost EDQ’s performance. 
(How to increase the Java Heap and the Oracle Database’s memory is described later in this 
guide, as you can only change these two settings once the VM has been started.) 

http://www.7-zip.org/
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1. Navigate to Oracle VM Virtual Box Manager.  Select the EDQ-12.1.3-Trn2 virtual 
machine and click Settings.  

 

2. In the EDQ-12.1.3-Trn2 – Settings screen, click System, and, if possible, increase the 
Base Memory allocated to the Virtual Machine.  Then click OK to close the EDQ-12.1.3-
Trn2 – Settings screen. 
 

 
It is difficult to give a hard and fast recommendation for what you should 
set the Base Memory to.  You need to leave enough memory at the 

disposal of the host system so that its performance is not affected.  How 

much you leave at the disposal of the host system depends on the 
specification of your particular machine and what other demands are 
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being placed on it.  The Base Memory allocated to the VM must not be 

decreased below its default value of 4GB, as this is required by the 
software installed on the VM for adequate performance.  In general 

terms, the more Base Memory you can allocate to the VM, the more you 

will be able to tune EDQ for better performance.  But if you allocate too 
much memory to the VM, the performance of your host system may 

suffer.  If your host system has 16GB memory, allocating around 9GB 
(that is 9216 MB) to the VM’s Base Memory is likely to enable both the 

VM and the host system to perform well. 

1.8. Set Up a Shared Folder 
It is useful to set up a Shared Folder so that you can move files between the host and the 
guest.  The instructions below tell you how to do this.  They assume that your host has a 
Windows operating system.  If this is not the case, it should be fairly simple to adapt the 
instructions to suit other operating systems, such as Linux or Mac OS X.  Likewise, if you want 
to set up a shared folder in a different location to that specified below, it should be quite simple 
to adapt the instructions accordingly. 

1. Create a folder called share in the root of your host machine’s C: drive. 

2. Create a text file containing a few lines of text.  Call it test.txt and place it in the 
C:\share folder on your host machine. 

You will use this text file later to confirm that your shared folder is 

working. 

3. Navigate to Oracle VM Virtual Box Manager.  Select the EDQ-12.1.3-Trn2 virtual 
machine and click Settings.  

 

4. In the EDQ-12.1.3-Trn2 – Settings screen, click Shared Folders and then click . 
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5. The Add Share dialog appears.  Select a Folder Path of C:\share and enter a Folder 
Name of share.  Select the Auto-mount check box and, if it is available, also select 
the Make Permanent check box (do not select ‘Read-only’): 
 

 

6. Click OK to close the Add Share dialog, and then click OK again to close the EDQ-
12.1.3-Trn2 – Settings screen. 

1.9. Shut Down any instance of the Oracle Database 
Running on the Host 

The virtual machine includes an instance of the Oracle database that holds the data used in the 
hands-on labs.  This will be accessed from the host via port 1521, which is the default port used 
by instances of the Oracle database.  In order to avoid contention, if you have an instance of 
the Oracle database already running on the host, and it uses the default port of 1521, you will 
need to shut it down before starting the virtual machine. 
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1.10. Start the EDQ-12.1.3-Trn2 Virtual Machine 
1. Return to Oracle VM VirtualBox Manager, select the EDQ-12.1.3-Trn2 Virtual Machine 

and click Start. 

 
The virtual machine will take a few minutes to start, during which time you will see 
messages about its progress in starting various services. 

 
It is possible that one or two services may seem to fail to start – this will not usually 
present a problem (in fact, a timeout causes the server to move on to start the next 
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service, but the previous service will in fact continue to start up, despite the apparent 
failure).  The final two notifications you will see relate to the WebLogic Admin Server 
and the EDQ Application Server.  Both of these services will take some time to start. 

In some cases the virtual machine may fail to start with the following 
error: Failed to open a session for the virtual machine EDQ-

12.1.3-Trn2.  VT-x features locked or unavailable in MSR. 
(VERR_VMX_MSR_LOCKED_OR_DISABLED).  This indicates that 

your host machine is not configured to support 64 bit virtualization (note 

that this can happen even if your host is a 64 bit machine).  In order to 
fix this, you may have to change your host machine’s bios settings.  For 

example, you may need to enable the Virtualization Technology option in 
the Bios’s Security menu. 

2. Wait until the virtual machine’s desktop appears.  You will be automatically logged in as 
the oracle user (for reference, the oracle user’s password is also oracle). 

 
You will not need to work within the virtual machine to access Oracle Enterprise Data 
Quality.  All access to EDQ will be via its user interfaces, which you will run on your 
host machine.  However, you may want to move files between the host and the guest 
(the EDQ-12.1.3-Trn2 virtual machine).  In a previous step you configured a shared 
folder to facilitate this.  Let’s check that the shared folder is working. 

3. If the virtual machine’s desktop appears untidy (for example, if icons appear to be 
overlayed), right-click anywhere on the desktop and select Clean Up by Name. 

4. On the virtual Machine’s desktop, you will see a folder called share.  This will enable 
you to access your shared folder. 
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5. Double click the share folder.  The share window will open: 
 

 
If the shared folder is properly configured, you should see the test.txt file that you 
created earlier and placed in the C:\share folder on your host machine.  Try dragging 
this file on to the virtual machine’s desktop – this should create a copy of the file within 
the virtual machine. 

Any file that you place in the C:\share folder in the host machine 

should be accessible from the share folder in the guest machine, and 
vice versa.  You can use the shared folder to move files between the 

host and the guest. 

1.11. If Possible, Increase Memory Allocated to the EDQ 
Application Server’s Java Heap and Increase the Oracle 
Database’s Memory Target Setting 

EDQ’s platform is comprised of an application server (Oracle WebLogic in this case) and a 
database repository (provided in the case by the Oracle Database).  In general terms, you can 
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boost the performance of EDQ by increasing the amount of memory allocated to the application 
server’s Java Heap and by increasing the amount of memory allocated to the Oracle Database.  
However, you should only do this if you were able to increase the amount of Base Memory 
allocated to the virtual machine earlier in the installation process.  If you were not able to 
increase the amount of Base Memory allocated to the Virtual Machine from its default of 4GB, 
do not change the amount of memory allocated to the application server’s Java Heap or the 
Oracle Database. 

Note that you must restart the virtual machine at the end of this 

procedure. 

1.11.1. If Possible, Increase Memory Allocated to EDQ Application 
Server’s Java Heap 

1. To increase the EDQ Application Server’s Java Heap you need to edit a file called 
startManagedWebLogic.sh.  This file is in the following location on the virtual 
machine: 

a. /apps/oracle/fmw/user_projects/domains/edq_domain/bin 

Navigate to this location by clicking the Computer icon on the virtual machine’s desktop 

 
Next, click Filesystem, and then navigate through the file system until you reach the 
right location. 
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2. Double-click startManagedWebLogic.sh and then click Display to open the file. 
 

 

3. To increase the size of the Java Heap allocated to the application server, increase the 
value of the following two JAVA_OPTIONS: 

a. -Xms 

b. -Xmx 

These two JAVA_OPTIONS control the minimum and maximum size of the Java Heap 
respectively.  You can often achieve optimal performance by setting them to the same 
value.  If you were able to allocate 9GB of Base Memory to the VM, then the 
recommended setting for these two JAVA_OPTIONS is 2560M. 
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4. Click Save and then close the file. 

As noted above, only change the amount of memory allocated to EDQ 

application server’s Java Heap if you were able to increase the amount of 
Base Memory allocated to the Virtual Machine from its default of 4GB. 

1.11.2. If Possible, Increase Memory Allocated to the Oracle 
Database 

1. To increase the amount of memory allocated to the Oracle Database you need to edit a 
file called initorcl.ora.  This file is in the following location on the virtual machine: 

a. /apps/app/oracledb/oracle-base/product/12.1.0/dbhome_1/dbs 

Navigate to this location by clicking the Computer icon on the virtual machine’s desktop 

 



Virtual Machine Installation Guide, Release 12.1.3 
 

 

 

 

Page 15 of  31 Copyright © 2015, Oracle and/or its 
affiliates. All rights reserved. 

 

 

Next, click Filesystem, and then navigate through the file system until you reach the 
right location. 

2. Next, double-click initorcl.ora to open the file. 
 

 

3. To increase the memory allocated to the Oracle Database, increase the value of the 
following parameter: memory_target. 

If you were able to allocate 9GB of Base Memory to the VM, then the recommended 
setting for memory_target is 4096m. 
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4. Click Save and then close the file. 

As noted above, only change the amount of memory allocated to the 

Oracle Database if you were able to increase the amount of Base 
Memory allocated to the Virtual Machine from its default of 4GB. 

1.12. Restart the Virtual Machine 
1. Navigate to the EDQ-12.1.3-Trn2 virtual machine’s desktop. 

2. From the Machine menu, select ACPI Shutdown. 

3. A dialog box will ask you whether you want to shut down the system now.  Click 
Restart. 
 

 

4. Wait for the virtual machine to finish its reboot. 
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2. (Optional): Map Virtual Machine Folders to 
Windows Drives 

2.1. About Mapping Drives 
You can map Windows drives from the host to the guest because the 
guest VM has an instance of Samba installed and configured.  Note that 

the Windows drives you map may not function if your host machine is 
connected to a Virtual Private Network. 

Another method of moving files between the guest and host – and one that you may find 
convenient - is to map Windows drives on the host machine to the guest (obviously, this 
assumes that your host is a Windows computer).  You should also be able to open files stored 
on the guest in applications running on the host (so, for example, you could open a 
spreadsheet stored on the guest in an application running on the host).  This step involves a 
little extra configuration, and so is optional.  You can do all of the EDQ training without 
completing this lab, but you may find moving files easier and quicker if you do complete this 
lab. 

The instructions below relate to mapping drives from hosts running the 

Windows 7 Operating System.  You may have to adapt them slightly for 
other versions of Windows.  Note that it is also possible to map drives 

from hosts running on other operating systems. 

2.2. Shut Down the Virtual Machine 
1. Navigate to the Virtual Machine’s desktop, and from the System menu, select Shut 

Down… 
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2. A dialog box will ask you if you want to shut down the system Now.  Click Shut Down. 
 

 

3. If any further dialog boxes appear, click OK. 

4. Wait until the system has fully shut down. 

2.3. Check Virtual Box’s Host-only Network Settings 
1. Navigate to the Oracle VM VirtualBox Manager.  From the File menu, select 

Preferences… 
 

 
If your host is running on Mac OSX, you will find the Preferences 
option under the VirtualBox menu. 

2. The VirtualBox – Settings dialog is displayed.  Click Network and ensure that a Host-
only Network called VirtualBox Host-Only Ethernet Adapter is present. 
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If no Host-only Network is present, click  to create one.  If your 

Host-Only Network has a different name, then make a note of it, as you 
will need it in a later step. 

3. Double click VirtualBox Host-Only Ethernet Adapter.  The Host-only Network 
Details dialog is displayed.  Navigate to the DHCP Server tab, and ensure that the 
Enable Server check box is selected. 
 

 
If the Enable Server checkbox is not selected, then select it. 

4. Click OK to close the Host-only Network Details dialog. 

5. Click OK to close the VirtualBox – Settings dialog. 
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2.4. Enable the EDQ-12.1.3-Trn2 Virtual Machine’s Host-only 
Adapter 

1. Navigate to the Oracle VM VirtualBox Manager.  Select EDQ-12.1.3-Trn2, and 
click Settings. 
 

 

2. The EDQ-12.1.3-Trn2 – Settings window is displayed. 

3. Click Network.  Navigate to the Adapter 2 tab and select the Enable Network 
Adapter check box. 

 

4. Ensure that the following settings are selected: 

a. Attached to Host-only Adapter. 
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b. Name:  VirtualBox Host-Only Ethernet Adapter. 
 

 
If your Host-only Network is not called VirtualBox Host-Only 
Ethernet Adapter, then select your Host-Only Network’s name in the 

Name dropdown.  If your Host-only Network is called VirtualBox 

Host-Only Ethernet Adapter, then you can leave the settings 
unchanged. 

5. Click OK to close the EDQ-12.1.3-Trn2 – Settings window. 
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2.5. Start the Virtual Machine 
1. Ensure that the EDQ-12.1.3-Trn2 virtual machine is selected, and click Start. 

 

 

2. The virtual machine will take a few minutes to start.  Wait until the desktop appears.  
You will be automatically logged in as the oracle user. 
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2.6. Map Virtual Machine Folders to Windows Drives 
1. On the host machine, open Windows Explorer. 

2. From the Tools menu, select Map network drive…  The Map Network Drive dialog is 
displayed. 

3. Select a Drive of L: 

If your L: Drive is already used, you can select a different drive letter. 

4. In the Folder field, enter \\edqtrn\VMlandingarea. 

5. Ensure that the Reconnect at logon checkbox is selected. 

6. Ensure that the Connect using different credentials checkbox is not selected. 

7. Click Finish. 

It is also possible to use Samba to access folders and files inside the 
guest VM from a host running on another operating systems.  For 

example, in Mac OS X open the Finder, and from the Go menu, select 

Connect to Server…, and enter a Server Address of 
smb://edqtrn/[folder name]. 

8. Repeat steps 2 – 7 to map the following: 

a. Drive: O: Folder:  \\edqtrn\VMoedq_local_home 

b. Drive: V: Folder:  \\edqtrn\VM 

edqtrn, which you can see in the Folder fields above, is the virtual 
machine’s ‘hostname’.  If you cannot successfully map the drives above, 

it may be because the VM’s ‘hostname’ is not recognized.  To overcome 
this problem, substitute the VM’s ip address for the hostname.  To find 

the VM’s ip address, navigate to the VM’s desktop and double click 

Terminal to open a terminal window.  In the terminal window, enter 
ifconfig.  Use the inet addr of eth1 as the ip address. 

 

 

Note that eth1’s Inet addr may not be the same as displayed above. 
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3. (Optional): Enable Address Verification 

3.1. About Enabling Address Verification 
Oracle Enterprise Data Quality Address Verification is not required for the 

Getting Started with Oracle Enterprise Data Quality lab.  These 
instructions are provided in case you want to evaluate Address 

Verification. 

The EDQ-12.1.3-Trn2 virtual machine includes an installation of the Oracle Enterprise Data 
Quality Address Verification Server.  However, the Address Verification Server requires the AV 
Global Knowledge Repository (GKR).  The GKR is not installed in the virtual machine.  The GKR 
is not included in the virtual machine for two reasons: 

1. Including the GKR would have significantly increased the size of the VM. 

2. Providing the GKR would not be within the terms of the agreement with the third-party 
who provide the GKR. 

'Out of the box', therefore, EDQAV will not work.  However, it is fairly straightforward to 
configure the EDQ-12.1.3-Trn2 virtual machine so that its Address Verification server will work 
with a GKR that is installed on your host machine. 

3.2. Enable Address Verification 
1. Install the Global Knowledge Repository (GKR) on your host machine. 

Note that the EDQ-12.1.3-Trn2 virtual machine requires version 14.4 of 

the GKR or above.  If it is already installed, there is no need to install it 

again.  For instructions to install the Global Knowledge Repository data 
files for Address Verification using the Install Manager, use the 

documentation provided at the Loqate web site at 

http://www.loqate.com/support/releases/. 

 

2. Navigate to Oracle VM Virtual Box Manager.  Select the EDQ-12.1.3-Trn2 virtual 
machine and click Settings.  

 

http://www.loqate.com/support/releases/
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3. In the EDQ-12.1.3-Trn2 – Settings screen, click Shared Folders and then click . 
 

 
 

4. The Add Share dialog appears.  Select the location of your GKR as the Folder Path, 
and enter a Folder Name of av_share.  Select the Auto-mount check box and, if it 
is available, also select the Make Permanent check box (do not select ‘Read-only’). 

By default the GKR is installed on Windows machines at C:\Program 

Files\EDQAV\data. 

5. Click OK to close the Add Share dialog, and then click OK again to close the EDQ-
12.1.3-Trn2 – Settings screen. 

6. Navigate to the EDQ-12.1.3-Trn2 virtual machine’s desktop. 

7. From the Machine menu, select ACPI Shutdown. 

8. A dialog box will ask you whether you want to shut down the system now.  Click 
Restart. 
 

 

9. Wait for the virtual machine to finish its reboot. 
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4. Open the Oracle Enterprise Data Quality 
Launchpad and Launch Director 

4.1. About the Lanuchpad 
The Oracle Enterprise Data Quality Launchpad is a web page that enables you to launch Oracle 
Enterprise Data Quality user interfaces. The URL of the Launchpad has been preconfigured 
within the Virtual Machine. 

4.2. Navigate to the Launchpad 
1. Ensure that the EDQ-12.1.3-Trn2 virtual machine is running. 

2. Open a web browser on your host and navigate to the following URL: 
http://localhost:8011/edq. 

 

 
Note that the Launchpad may take some time to display when you have 

just started the virtual machine (this is because the EDQ server is 
starting).  Be patient, and it should appear. 

3. In your web browser, make the Launchpad web page a favorite or bookmark it so you 
can easily return to it in future.  

4.3. Launch Director 
Note that to launch the Director user interface, you will need an up to 
date Java Runtime Environment (JRE) installed on your host computer.  

You can download a Java Runtime Environment from 

http://www.java.com. 

http://localhost:8011/edq
http://www.java.com/
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1. On the Launchpad, click the Director link to launch the application.  Allow any Java 
webstart confirmation boxes that may appear so that the client software can be 
downloaded.  If you are asked whether you want to run the application, click Run.  If a 
dialog box warns you that the Windows Firewall has blocked some aspects of the 
program, click Unblock.  If a dialog box warns you that dxi files already have an 
association, just click OK. 

Director is one of Oracle Enterprise Data Quality’s rich, Java Web Start 

user interfaces.  Clicking the Director link from the Launchpad within 
your host machine causes the user interface to download via Java Web 

Start from the EDQ server, which is running within the EDQ-12.1.3-Trn2 
virtual Machine.  Once it has been downloaded, the user interface will 

invite you to login.  And once you have done this, you will be able to 

interact with the EDQ server, which is running in the guest virtual 
machine, via the Director user interface, which is running on the host. 

2. The Login to localhost dialog will open.  Login with the following credentials: 

a. Username: dnadmin 

b. Password: dnadmin 
 

 
 

dnadmin is a superuser.  It has all the security privileges available in 

EDQ.  In a live environment, in which many users may interface with the 
same EDQ server, most users will have a more restricted set of 

privileges.  However, in the training environment, which is figuratively a 
sandpit, it will be useful for you to enjoy unrestricted access to all EDQ 

functionality. 
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The Director user interface opens: 
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5. Complete the Getting Started With Oracle 
Enterprise Data Quality Hands-on Lab 
1. On the EDQ-12.1.3-Trn2 virtual machine’s desktop you will see a shortcut to the Getting 

Started with EDQ hands-on lab. 
 

 

2. Double click this shortcut, and the lab will open in a web browser. 

3. Complete the hands-on lab to start learning about EDQ. 
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6. Appliance Credentials and Other Useful 
Information 

EDQ username: dnadmin 

EDQ password: dnadmin 

EDQ Launchpad URL (from your host machine): http://localhost:8011/edq 

 

Credentials, and other details, for the other software applications included within the VM can be 
found within the virtual machine itself. 

1. On the EDQ-12.1.3-Trn2 virtual machine’s desktop you will see a shortcut called About 
This Virtual Machine. 
 

 

2. Double click this shortcut, and the About This Virtual Machine document will open in a 
web browser. 

 

 

http://localhost:8011/edq
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7. Learning More About EDQ 
Information about how to learn more about EDQ, including useful links to education resources, 
is contained within the virtual machine itself. 

1. On the EDQ-12.1.3-Trn2 virtual machine’s desktop you will see a shortcut called Learn 
About EDQ. 
 

 

2. Double click this shortcut, and the EDQ Learning Resources document will open in a 
web browser. 

 


